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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product 
value chain. 

Audience
This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support 
through My Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle 
Technology Network (OTN) Web site 
http://www.oracle.com/technetwork/documentation/agile-085940.html contains 
the latest versions of the Agile PLM PDF files. You can view or download these 
manuals from the Web site, or you can ask your Agile administrator if there is an Agile 
PLM Documentation folder available on your network from which you can access the 
Agile PLM documentation (PDF) files. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.
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monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.

Convention Meaning
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1Introduction 

This document introduces Agile PLM Monitoring using Oracle Enterprise Manager 
Grid Control. It guides you through the process of creating and configuring Agile 
Landscape targets and discusses Agile transactions. It provides the following 
information:

Agile PLM Monitoring with Oracle Enterprise Manager Grid Control
Oracle Enterprise Manager 10g provides multi-instance monitoring of Agile PLM 
applications to deliver comprehensive, efficient, and vital health status information 
such as performance metrics, availability, and end-user experience. To enable this, you 
need to configure the following plug-ins:

■ agilePlugin - to monitor Agile PLM instances.

■ empluginpharma - to monitor Recipe & Material Workspace instances.

■ tomcat_plugin - to monitor Agile File Manager instances

This manual describes how you can install and configure these plug-ins. The 
configuration procedures for both plug-ins are similar and any variances are noted.

The plug-ins are available at the following location within the Agile PLM installation 
directory.

Name Plug-in Location

Agile PLM agilePlugin.jar <AGILE_HOME>\agileDomain\emplugin\

Recipe& Material 
Workspace

empluginpharma.jar <AGILE_HOME>\AgilePharma\emplugin\

Tomcat tomcat_plugin.jar <AGILE_HOME>\agileDomain\emplugin\

Supported releases:

■ Oracle Enterprise Manager Agent 10.2.0.4 and 10.2.0.3.

Note: Oracle recommends Oracle Enterprise Manager Agent Release 
10.2.0.4
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System Requirements
Before configuring Grid Control 10g Release 4 (10.2.0.4) to manage Agile applications, 
you must:

■ Install and configure Grid Control 10gR4 and 10g Release 2 (10.2.0.2) on at least 
one host computer on the network.

■ Install the Grid Control components on their own host or hosts. For example, if 
you install Agile monitoring middle tier on host1.us.oracle.com, then install and 
configure the Oracle Management Service and Oracle Management Repository on 
host2.us.oracle.com.

■ Install the Grid Control 10.4 Oracle Management Agent on every host that 
includes components that you want to manage with Grid Control.

Pre-requisites:
1. Install Oracle Enterprise Manager Agent Release 10.2.0.3 or later. Make sure the 

agent can successfully communicate with Oracle Enterprise Manager Server and 
upload data. For example, Agent Availability must be UP, Last Load Time must 
show a recent date/timestamp, and ensure to update the Last Load Time 
periodically.

2. Install Agile PLM Release 9.3.5.

Note: The Oracle Enterprise Manager Agent need not reside on the 
same machine where Agile PLM is installed.

While installing Agile, you need to know:

■ The Host of Agile PLM instance.

■ The JMX Port Number of the Agile PLM instance.

■ If you are enabling authentication for JMX on Agile PLM instance, you require the 
JMX Username and the JMX Password.

■ The Communication Protocol of Agile PLM instance.

■ The Service Name of Agile PLM instance.

■ If you are enabling SSL for JMX on Agile PLM instance, you require the SSL Trust 
Store and the SSL Trust Store JMXPassword.

■ The Agile Version of the Agile PLM instance (Not mandatory).

Note:  Ensure that you load the Agile PLM instance.

■ Note that the installer hard codes the below Port Numbers.

■ Port number for Agile PLM - 9899

■ Port number for Recipe & Material Workspace-8899

■ Port Number for Apache Tomcat - 9898

■ Default Communication Protocol and Services names are rmi and jmxrmi.

■ Before configuring Grid Control 10g Release 4 (10.2.0.4) to manage Agile 
application, Oracle recommends that you install the Grid Control components on 
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their own host or hosts. For example, if you install Agile on host1.us.oracle.com, 
then install and configure the Oracle Management Service and Oracle 
Management Repository on host2.us.oracle.com.

■ Install the Grid Control 10.2 Oracle Management Agent on every host that 
includes the components you want to manage with Grid Control.

See the Enterprise Manager Installation and Configuration Guide, on The Oracle 
Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/oem.html for details on 
performing these steps.

Setting Credentials in Oracle Enterprise Manager
You need to set credentials in Oracle Enterprise Manager for the user that the agent 
runs as. You can either set default credentials (which are the same for all agents) or 
different credentials for each agent (target credentials). Target credentials override 
default credentials.

To set credentials:

1. Click Preferences in the Oracle Enterprise Manager home page.

2. Click Preferred Credentials.

3. Click the icon in the Set Credentials column in the row for the agent. The Agent 
Preferred Credentials page appears.

4. Enter default and target credentials by entering the operating system username 
and password for the agent.

5. In the Host UserName column, enter username.

6. In the Host Password column, enter password.

7. Click Apply.

Granting 'Log on as a Batch Job' Privilege
On Windows, you need to grant to the host username the Log on as a Batch Job 
privilege. Set credentials for agents by setting the host username and host password in 
Oracle Enterprise Manager Grid Control.

To grant Logon as a batch privilege on Windows:

1. Set the control panel to classic view.

2. From the desktop, choose Start > Control Panel > Administrative Tools.

3. Double click Local Security Policy.

4. Click Local Policies.

5. Click User Rights Assignment.

6. Double-click Log on as a Batch Job. The Log on as a Batch Job Properties dialog 
appears.

7. Click Add User or Group. The Select Users or Group dialog appears.

8. In the Enter the Object Names to Select dialog, enter username of the host.

9. Click OK.
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Additional Sources of Information
Refer to the URL below for additional information about Agile instance monitoring. 
The base documentation is applicable in many cases, because Agile instance 
monitoring leverages many of Enterprise Manager's underlying capabilities.

See also: The Enterprise Manager Concepts Guide, which gives you more information 
on the capabilities of Oracle Enterprise Manager Grid Control at The Oracle 
Technology Network (OTN) Web site at 
http://www.oracle.com/technology/documentation/oem.html 
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2Monitoring Agile Targets

Oracle Enterprise Manager Grid Control 10gR4 enables the monitoring of Agile PLM 
applications along with other Oracle and non-Oracle technologies through a single 
Oracle Enterprise Manager Grid Control console.

Key Benefits
It provides:

■ Centralized, multi-tier, multi-instance Agile PLM monitoring.

■ Discovery of Agile PLM servers and instances for each monitored SID.

■ Comprehensive, efficient, and secure health status data collection.

■ End-user experience monitoring for Agile PLM application modules.

■ Agile PLM business service dashboards and performance trend reports.

Note: Use of this capability requires Agile PLM Plug-in for Oracle 
Enterprise Manager 10g. Use of other Oracle Enterprise Manager 
capabilities may require additional licenses.

Prerequisites for Monitoring Agile Targets
After deploying Agile, perform the following steps to monitor an Agile target by using 
Enterprise Manager Grid Control:

■ Install Enterprise Manager Grid Control with licenses.

■ You must install EMGC 10.2.0.2.0 before you upgrade to 10.2.0.4.0.

■ Name the queues OEM_AGENTS and OEM_METRICS.

■ Install Enterprise Manager 10g R4 agent on the machine where you install the 
plug-in.

Agile Landscape Targets
Agile Landscape enables administrators to organize distributed targets for efficient 
and effective management and monitoring.
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Adding an Agile Landscape
To add an Agile landscape:

1. Click the Targets tab, from the Enterprise Manager Console.

2. Click the Agile tab.

3. Click Add. The Add Agile Landscape page appears. Define values for all the 
parameters.

4. Click OK.

The progress page notifies you when Agile Landscape and its associated targets are 
created.

Removing Application Instances from an Existing Landscape
After creating an Agile Landscape and associated targets, you can manually remove 
individual application instances from that landscape. This, however, deletes the 
respective target information from the Enterprise Manager repository.

Note: Enterprise Manager does not monitor the target, once an entry 
is deleted from the Enterprise Manager Repository.

Listed below are the two possible paths for manually removing application instances 
from an existing landscape:

To manually remove application instances from existing landscape - Path 1:

1. Navigate to All Targets tab.

2. Locate the application instances you want to delete.

3. Check the Select option.

4. Click Remove.

To manually remove application instances from existing landscape - Path 2:

1. Navigate to Agile Applications tab.

2. Select Agile Landscape View.

3. Navigate to the enterprise you want to remove.

4. Check the Select option.

5. Click Remove.

Path 2 option removes the Agile server, targets, and all instances of the application.
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3Agile Plug-in Configuration

This chapter describes how to import, configure, and deploy the plug-in.

Importing a Plug-in
Plug-ins define and deploy an agent to manage and monitor a target. Before you begin 
the import process, you need to download the plug-in from the Agile Application 
server and save the plug-in file (agilePlugin.jar/ empluginpharma.jar/tomcat_
plugin.jar) to the machine where the browser is running.

Name Plug-in Location

Agile PLM agilePlugin.jar <AGILE_HOME>\AgilePharma\emplugin

Recipe & Material 
Workspace

empluginpharma.jar <AGILE_HOME>\agileDomain\emplugin 
empluginpharma.jar

Tomcat tomcat_plugin.jar <AGILE_HOME>\agileDomain\emplugin 
tomcat_plugin.jar

You can now log in to the Oracle Enterprise Manager Grid Control from the browser.

To import plug-ins:

1. Log in to the Oracle Enterprise Manager Grid Control.

2. Enter username and password of the Super Administrator in the Username and 
Password columns.

3. Press Return or click Login. The Oracle Enterprise Manager Grid Control Home 
page appears.

4. Click Setup. The Oracle Enterprise Manager Setup page appears.

5.  Click Management Plug-ins in the Overview of Setup panel section. The 
Management Plug-ins page appears.

6. Click Import from the Management Plug-ins page. The Import Management 
Plug-ins page appears.

7. Click Browse to locate the plug-in archive file.

The plug-in archive file is the .jar file you have downloaded. The file is located in 
the file system where the browser resides. (For example, if the browser resides on 
the Windows platform, you can locate the file on the desktop or in one of the 
folders on the drive).

8. Select the file. You see the path and filename of plug-in jar file in the text field 
named Management Plug-in Archive.
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9. Click List Archive.

The Management Plug-in Archive (MPA) plays an important role at various stages 
of the plug-in life cycle. It serves the following functions.

■ Acts as a transport mechanism between the development environment and the 
Enterprise Manager framework.

■ Acts as a transport mechanism between different Enterprise Manager 
installations.

■ Acts as a container for the Management Plug-in. MPAs may contain multiple 
Management Plug-ins.

10. Check the Select option. You can now import the plug-in.

11. Click the OK button. The process of importing the plug-in begins.

On completion, the Setup page displays a message confirming successful import. You 
can now deploy the plug-in to one or more agents.

Creating a Target Instance
You can create a target instance of the plug-in on one or more agents and for each 
unique Agile PLM Server. You can configure Agile Server as one of the targets for the 
agent and the agent begins the process of monitoring the target.

1. Click Agents on the Setup page.

2. The Agents page appears. A list of the agents you deployed the plug-in to appears.

3. Select and click the Agent link. The Agent Name page appears.

4. Click the Add drop-down list and select target type as below.

■ To add Agile PLM, select AgilePLM from the Add drop-down menu. Click Go. 

■ To add Apache Tomcat, select Apache Tomcat from the Add drop-down menu. 
Click Go.

■ To add RMW, select AgilePharmaEM from the Add drop-down menu. Click 
Go.

In the Name column, you create a target instance name. Define the name as a 
meaningful identifier. (For example, Agile93PLM_hostname_instance). The name can 
be any string including letters, numbers, and special characters.

1. Enter the target instance name in the Name column.

2. Enter the host name of the Agile PLM/RMW instance in the Host column.

3. Enter the Port number in the JMX Port Number column.

4. If you enable authentication:

■ Enter the JMX username.

■ Enter the JMX password.

■ Enter the protocol in the Communication Protocol.

■ Enter the name in the Service Name column.

5. If you enable SSL:

■ Enter the SSL trust in the SSL Trust Store column.

■ Enter the JMXPassword in the SSL Trust Store JMXPassword column.
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6. Enter the version of the Agile PLM/RMW instance in the Agile Version column.

7. Click OK.

You can now view information about the created target instance.

Deploying the Plug-in
Deploying the plug-in to one or more agents begins the process of monitoring the 
target. After successfully deploying the plug-in, you can configure Agile Server as one 
of the targets for the agent. The agent then begins the process of monitoring the target.

To deploy the plug-in:

1. Ensure you are in the Oracle Enterprise Manager Setup page.

A table displays several columns containing information about the plug-in. For 
example, the name column displays Agile, Deployed Agents column displays 0 (if 
you have not previously deployed one or more agents), and Description column 
displays Management Plug-in for Agile PLM.

2. Check the Select column.

3. Click Deploy. The Deploy Management Plug-in: Select Targets page appears.

4. Click Add Agents. A dialog appears. You can now search for the known agents.

5. Click Go.

6. Check the Select option for each agent you wish to deploy the plug-in to, from the 
list of agents.

7. Click Select. A list of deployment agents appears.

8. Click Next. The Deploy Management Plug-in: Review page appears. This page 
briefly describes the deployment process.

9. Click Finish.

The Setup page displays the message: “Deploy operation completed”. The number of 
agents deployed appears in the Deployed Agents column.

You are now ready to create a target instance.
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4Reports

Reports are generated from the metric information that you collect and store in the 
Oracle Enterprise Manager repository. Reports display detailed information as per 
pre-defined criteria, help monitor and analyze performance, and track usage. You can 
view Reports at the end of the process.

Generating Reports
You can generate the following categories of reports:

■ Agile Chart Reports

■ Deployment and Config

■ Enterprise Manager Setup

■ Monitoring

■ Security

■ Storage

To generate reports:

1. Click the Oracle Enterprise Manager Home page.

2. Select the host name.

3. Click Targets.

4. Click the Reports button. The Report Definition page appears.

5. Select Agile Chart Reports > Interesting Agile Data > User Usage Report and 
specify a target for Report.

6. Select a Target.

7. In the Search and Select Targets page, enter Agile PLM in the Target type field.

8. Click Go.

9. Select the Target and click Continue. A graphic display of the Report appears. The 
report displays a graph of

■ Users: Logon Users

■ Sessions: Logon Sessions
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Available Reports
With Tomcat and Enterprise Manager, monitoring can be either real-time or historical. 
The administrators can view these reports to monitor the health of targets. With each 
Tomcat installation, you must configure the Agile monitoring probe that provides 
metric details to the Tomcat hub. When you install EM agent, the agent receives alerts 
and messages from the EM queue and stores the statistics in the EM repository.

You have three options:

■ 24 hours - provides the statistics for the last 24 hours.

■ Seven days - provides the statistics for a week.

■ 31 days - provides the statistics for the last 31 days.

Scenarios
Enterprise Manager provides a powerful reporting framework called Information 
Publisher. Given below are a few reports run by Agile.

Agile Concurrent User Usage Report
Agile Concurrent User Usage Report is based on this framework and shows the 
concurrent user numbers by day.

Figure 4–1 Agile Concurrent User Usage Report
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Performance Summary
Given below is a graphic display of the Performance Summary View.

Figure 4–2 Performance Summary - CPU Utilization

Figure 4–3 Performance Summary - Memory Utilization
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Figure 4–4 Performance Summary - Disk Utilization

CPU Details
Given below is a graphic display of the CPU Details View.

Figure 4–5 CPU Details - CPU Utilization

Figure 4–6 CPU Load
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Memory Details
Given below is a graphic display of the Memory Details View.

Figure 4–7 Memory Details - Memory Utilization

Figure 4–8 Memory Details - Swap Utilization

Disk Details
Given below is a graphic display of the Disk Details View.

Figure 4–9 Disk Details - Disk Utilization
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Figure 4–10 Disk Details - Longest Service Time
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5Agile Metrics

The plug-in collects and displays information and performance metrics for the target 
Agile PLM. 

About Agile Metrics
This section provides descriptions for all the Agile metrics that you monitor. The table 
below lists and describes the metrics.

Metric Description

Maximum CPU Usage (%) The maximum usage of CPU usage.

Maximum DB time (ms) Usage of database time for single dialog program.

Maximum Dialog Response Time (ms) Average dialog response time.

Actual Number of Users The current number of users logged in to the Agile 
system.

There exists the current numbers of users system-wide and for each application server 
instance.

Metric Description

Maximum usage of extended memory (%) The maximum usage of extended memory.

Minimum for program buffer hit ratio (%) Hit ratio of Program buffer.

Waiting Queue for dialog process The dispatcher queue that measures the number 
of dialog process requests waiting for a free dialog 
process. This should be zero in an optimally 
tuned landscape (SID).

Hit Ratio Table Definition Hit ration table definition.

Maximum % of memory paged out Paging out rate.

Maximum usage of roll area (%) Maximum usage of roll area.

The Oracle Enterprise Manager All Metrics page displays metric information.

To navigate to the All Metrics page:

1. Click Targets on the Navigation bar of the home page. The Host page appears.

2. Click All Targets. The All Targets page displays a list of all targets in the Oracle 
Enterprise Manager Grid Control including hosts, agents, and databases.
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3. Select the target instance option - Agile PLM or AgilePharmaEM.

4. Click All Metrics from the list of options.

The Oracle Enterprise Manager Metrics page displays menu options for Agile 
Information, User Usage and Response.

Agile Information
To view information about Agile PLM or RMW, click About Agile / Recipe& Material 
Workspace on the Oracle Enterprise Manager Metrics page.

User Usage Information
To view Agile PLM or RMW user usage information, click User Usage on the Oracle 
Enterprise Manager Metrics page. The User Usage page displays the following 
information:.

Name Description

Users Logon User Number

Sessions Logon User Sessions Number

Response Information
To view response information, click Response on the Oracle Enterprise Manager 
Metrics page. The Response page displays response information for the Server 
including:

■ Status (up or down)

■ Response time (sec).
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6Deleting Plug-ins

This chapter describes how to remove the Agile plug-in from Oracle Enterprise 
Manager Grid Control.

Removing Target Instances of the Plug-in
To remove target instances of the plug-in:

1. Click Targets on the Navigation bar of the Home page. The Host page appears.

2. Click All Targets.

3. The All Targets page that displays a list of all targets in the Oracle Enterprise 
Manager Grid Control including hosts, agents, and databases.

4. Select the target instance option - Agile or RMW or Tomcat.

5. Click Remove. You see the warning message: "You have chosen to remove Target_
instance_name (Agile PLM). Do you wish to proceed"?

6. Click Yes. A confirmation message: "Target_instance_name (Agile PLM) has been 
deleted" appears.

Repeat steps 1-5 to remove additional target instances of the plug-in. 

7. Remove all target instances of the plug-in before you undeploy and delete the 
plug-in Oracle Enterprise Manager Grid Control.

Example 6–1 

If you have three Agile PLM Servers (three target instances) and you deploy two 
Servers to one agent and the third Server to a second agent, you must:

■ Remove Server 1 (the target instance) on agent 1

■ Remove Server 2 (the second target instance) o agent 1

■ Remove Server 3 (the third target instance) on agent 2

Undeploy and delete the plug-in from the Oracle Enterprise Manager Grid Control.

Undeploying the Plug-in
Ensure to remove all target instances of the plug-in before you undeploy the plug-in 
from the agents. You can undeploy the plug-ins from the Setup Menu.
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To undeploy the plug-ins:

1. Click Setup from the Navigation bar. The Oracle Enterprise Manager Setup page 
appears.

2. Click Management Plug-ins from the Overview of Setup panel section. The 
Management Plug-ins page appears.

3. Select either Agile PLM or AgilepharmaEM or Agile Tomcat option.

4. Click Undeploy. the Undeploy Management Plug-in page appears.

5. Select the deployed agents you want to undeploy.

6. Click OK.

The Setup page displays a message: "Undeploy operation completed". The Deployed 
Agents column displays 0.

Deleting Plug-ins
To delete the plug-in:

1. Select the row for the plug-in, in the Management Plug-ins page.

2. Click Delete.

3. Confirm the prompt message: "Are you sure you want to delete the following 
Management Plug-ins?” and click OK.

A confirmation message: “One Management Plug-in was successfully deleted”, 
informs you of having successfully deleted the plug-in.
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ACP

See Agile Configuration Propagation (ACP)

Affected Files

Similar to Affected Items, these objects are EC files that are Design Release Candidates.

Agile Configuration Propagation (ACP)

Propagating existing configuration the PLM to the newly installed version of PLM.

ACS

See Agile Content Service (ACS)

Agile Content Service (ACS) 

ACS is an event-driven XML-based publishing service that makes the product record 
available to a wide variety of business applications and users, internally and across the 
global manufacturing network

Agile Destination

A package created by an Agile PLM system in the target PLM using Web Services to 
import from the Attachments tab of the package in the target system.

Agile Integration Services (AIS)

A collection of predefined Web Services in the Agile Integration Framework that 
enable communication between the Agile Application Server and disparate systems

AI

Affected Items tab on Change objects in Agile.

AIS

See Agile Integration Services (AIS).

Approved Manufacturer Parts List (AML)

List of approved manufacturer parts associated with an item.

AML

See Approved Manufacturer Parts List (AML).

API

See Application programming interface (API).
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Application programming interface (API)

A set of routines, protocols, and tools for building software applications. An API 
expresses a software component in terms of its operations, inputs, outputs, and 
underlying types.

Assembly

A product assembly lists the parts in a product and shows the substances and 
materials that comprise those parts. It is linked to specifications that can restrict how 
much of a particular substance that product assembly may contain

Audit

An audit is the pro-active process of verifying compliance with quality requirements.

Automated transfer orders (ATO)

Content published by Agile PLM users in real time with a content transfer order (CTO) 
or set up subscribers to automatically create automated transfer orders (ATO) based on 
a schedule or triggered by a workflow status change.

Bill of Material (BOM)

A hierarchical representation of a product that is made up of other products.

Bill of Substances (BOS)

A hierarchical list of substances that are contained in the parts and assemblies that 
make up a BOM.

BOM

See Bill of Material (BOM).

BOS

See Bill of Substances (BOS). 

CAD

See Computer-aided design (CAD)

Corrective and Preventive Actions (CAPA)

The CAPA is a formal process of addressing any generic quality problems and 
analyzing the root cause so you can implement corrective and preventive actions.

Commodity

A class of goods that is in demand, that is supplied without qualitative differentiation 
regardless of supplier.

Computer-aided design (CAD)

The use of computer systems to assist in the creation, modification, analysis, or 
optimization of a design. CAD software is used to increase the productivity of the 
designer, improve the quality of design, improve communications through 
documentation, and to create a database for manufacturing. CAD output is often in the 
form of electronic files for print, machining, or other manufacturing operations.

Contract (Price)

This is a subclass of the Published Prices class. Contract prices are prices provided by 
the supplier for a specific item or manufacturer part. This price information applies 
only for the specified duration and can apply to any project.
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Co-Sourcing

The process of leveraging product cost across suppliers. 

DCO

See Design Change Order (DCO)

Design Change Order (DCO)

A Change Order subclass that is available when the effected File Tab is enabled and 
provides access to all Agile PLM Workflow functions.

Design File Folder

An EC file folder that is integrated with CAD and PLM files, providing full access to 
PLM Workflow function.

EC

See Engineering Collaboration (EC)

EC Client

A Java-based UI to access, administer and operated the EC solution.

ECO

See Engineering Change Order (ECO)

Engineering Change Order (ECO)

An object that carries with it all the proposed changes to a product and/or its BOM. 
When approved and implemented, the proposed changes become effective.

Engineering Collaboration (EC)

An application that provides data and process integration between CAD applications 
and Agile PLM. It allows CAD designers and engineers to capture and control the data 
representing a primary source of the product record.

Extensible Markup Language (XML) 

A markup language that defines a set of rules for encoding documents in a format that 
is both human-readable and machine-readable

File Manager

The File Manager manages files in a repository or vault in the file system and provides 
a place to store and retrieve files locally or remotely. You can install it on the same 
server as the Agile Application Server or on a separate one. You can also install the File 
in a redundant configuration and/or distributed across geographic regions. 

File Transfer Protocol (FTP)

A standard network protocol used to transfer computer files from one host to another 
host over a TCP-based network, such as the Internet.

FQPN

See Fully qualified path name (FQPN).

FTP

See File Transfer Protocol (FTP)
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Fully qualified file name

The exact name of a file on a computer that is completely specified such that it is 
unambiguous and cannot be mistaken for any other file on that system.

Fully qualified path name (FQPN)

The full path of a resource, directory or file, stored in a computer. It is composed by the 
full path to the resource and its syntax depends on the operating system.

Item Master

The product record. It is the entire collection of Items - Parts, Documents, and any 
other user-defined subclasses of the Items class maintained under change control in 
the Agile system.

Java Message Service (JMS)

The Java Message Service (JMS) API is a Java Message Oriented Middleware (MOM) 
API for sending messages between two or more clients.

JMS

See Java Message Service (JMS).

Lifecycle Phase

Current state in an object’s workflow.

LRR

Latest Released Rev - concerning a Part or Document. 

Non-Conformance Report (NCR)

NCR reports a basic material deviation from specifications or requirements in one or 
more products.

PDX

See Product Definition eXchange (PDX).

PG&C

Product Governance and Compliance is a solution designed to help manufacturers 
manage all kinds of product compliance.

PLM

See Product Lifecycle Management (PLM).

Problem Report (PR)

A Problem Report contains a basic description of a generic quality incident, problem, 
or incident reported from a customer's perspective

Product Definition eXchange (PDX)

A standard designed for the e-supply chain. This standard is based on the XML format 
because it provides a simple yet powerful and flexible way to encode structured data 
into a format that is both human- and computer-readable. In PLM, PDX packages 
contain product content, such as items.

Product Lifecycle Management (PLM)

The process of taking parts/documents from inception to production to phase-out, 
and all the stages in between.
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Product Service Request (PSR)

Product Service Requests report quality incidents, and aggregate many PSRs to a 
single PSR.

Protocol

A system of digital rules or agreed-upon format for data exchange within or between 
devices. It determines the type of error checking and data compression used.

Published Price

This is a subclass of the Published Prices class. Published prices are prices provided by 
the suppliers in response to an RFQ and published from the project. The published 
price information can also be used in other projects.

PCO

See Price Change Order

Price

An object that carries with it all the proposed changes to a product and/or its BOM. It 
can be approved and implemented to make the proposed changes effective.

Price Change Order

It is an object that carries with it all the proposed changes to a price. It can be approved 
and implemented to make the proposed changes effective.

Quality Change Request (QCR)

QCRs allow you to aggregate problems into a routable quality record, perform 
root-cause failure analysis, and drive the problems to closure using standard CAPA 
procedures.

Quote History

A subclass of the Quote Histories class. Quote history prices are the stored prices from 
supplier responses that you can use. Any change in the response line of an RFQ is 
stored in the historical response and is usable at any time.

Request for Information (RFI)

A material declaration that lists the parts in a product assembly and shows the 
substances and materials contained in the part.

Request for Quote (RFQ)

A standard business process whose purpose is to invite suppliers into a bidding 
process to bid on specific products or services.

Request for Proposal (RFP)

A solicitation, often made through a bidding process, by an agency or company 
interested in procuring a commodity, service or valuable asset, to potential suppliers.

Response Line

A response line has information about only one item. The negotiation of price and 
terms for items is dealt with in a response line.

RFI

SeeRequest for Information (RFI).
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RFP

See Request for Proposal (RFP) 

RFQ

See Request for Quote (RFQ)

RFQ Response

A medium of communication between the user and the supplier. One response from a 
supplier can contain multiple response lines for different items. Price data is added to 
the project automatically when the supplier submits the response.

Schema

In computer programming, a schema is the organization or structure for a database. 
The activity of data modeling leads to a schema.

SDK

See Software Development Kit (SDK or "devkit")

Software Development Kit (SDK or "devkit")

A set of software development tools that allows the creation of applications for a 
certain software package, software framework, hardware platform, computer system, 
video game console, operating system, or similar development platform.

Sourcing Project

The entry point of sourcing and product pricing. A sourcing project tracks data 
required for sourcing and pricing, to perform data analysis for effective pricing.

Supplier

A supplier of one or several commodities.

TLA

SeeTop Level Assembly (TLA)

Top Level Assembly (TLA)

The level in a BOM that indicates the ultimate product being manufactured. 

Transfer Order

Every time Agile Content Service (ACS) publishes product content, it produces a 
transfer order that keeps track of what, where, and when product content is 
transferred.

UPK

See User Productivity Kit (UPK)

User Productivity Kit (UPK)

The Oracle online help system used in some Oracle products.

Web Service Extensions (WSX)

A Web service engine that enables communication between Agile Product Lifecycle 
Management system and disparate internal and external systems. 

WSX

See Web Service Extensions (WSX). 
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XML

See Extensible Markup Language (XML).

XML Schema

Description of a type of XML document, typically expressed in terms of constraints on 
the structure and content of documents of that type, above and beyond the basic 
syntactical constraints imposed by XML rules.
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